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Objectives

Explore and learn how to use the tools in the Quantity Workflow to develop Plan
Summary Boxes and Summary of Quantity Sheets, export the data to Designer
Interface, and create the Summary of Pay Iltems Sheet.

Review Plan Summary Box Requirements

Create Summary Boxes through Linked Data Manager
- Automated

* Non-Automated

Generate Reports in Quantity Manager to use to fill in Summary Box
iInformation

Get guantity information to Designer Interface

Access AASHTOWare Project Reporting to get Project Summary Reports for
the Summary of Pay Items

Create Summary of Pay ltems Sheet FDDﬁ
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FDOT Standards e e e e

\SITIANDARD S/

« ALL quantities are to be documented by location on Plan Summary Boxes for
Roadway & Structures components.

* Plan Summary Boxes are to be located on the Summary of Quantities sheets.
« Plan Set Location

 Roadway — keep in same order sequence behind the Typical Section sheets

« Structures — Directly behind the Summary of Pay Items in the General Bridge section
(or behind the Key Sheet if no Summary of Pay Items sheet)

* Flle Name B. Start_the _sheet numbering with the Key Sheet numbered “B-jl"_ If quantities are _
* Roadway — SUMQRD™* the IndexKey Sheet Begin the auaniiies sheet nLmGering wih the prefix G 1 or
_Structures - B#SumofQuantities” | eSS Sres b RN AL 50 i B ot
* Sheet Prefix numbering for the first sheet of ths st bidge vith 811~ Contine fo use the "B
° Roadway — SQO- ol far all shstaiiit-tatajls parta® ol e ficst heife (PR 2" "R1-34 g |40

e Structures — BQ#-

FDOT\
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FDOT Standards e e e R e

'S TANDARDS!

 All other components (i.e. Signing & Pavement Markings, Signalization,
Lighting, etc.) are to use Tabulation of Quantities sheets.

* Drainage systems are to be documented on the Summary of Drainage
Structures sheets same as they have always been handled.
Do NOT add pay item numbers.

* Incidental drainage items to a project can be documented on the Summary
of Miscellaneous Drainage Items. Linear and Each items

 Intended for projects with Miscellaneous Drainage Items or on projects with
minimal drainage work, i.e. replacing broken inlet tops or moving structures to
accommodate added turn lanes, etc.

Do NOT include items in this box that are included on the Summary of Drainage

Structures sheets.
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FDOT Standards A= e

'SIT'T ANDAR

A listing of standard summary boxes is located in Chapter 8 of the BOE.

http://www.fdot.qgov/programmanagement/Estimates/BasisofEstimates/BOEManual/
Files/Chapter08SummaryBoxes.pdf

* Do NOT create non-standard boxes or modify current summary boxes with
Non-Standard columns or rows.

» Formatting in MicroStation is controlled through Excel files.
 FDOT templates have already been formatted for use.

« Columns and rows may be adjusted or hidden in Excel and change is reflected in
MicroStation when link is updated.

« Columns may be deleted when not used. However do NOT delete the
Construction Remarks or “F” columns.

* When copying data into the template files, make sure to use the
“Values Only” option to paste. Fnoﬁ
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http://www.fdot.gov/programmanagement/Estimates/BasisofEstimates/BOEManual/Files/Chapter08SummaryBoxes.pdf

Linked Data Manager (LDM)

 FDOT tool that uses Excel templates to generate Plan Summary Boxes.

* Creates a link between the Excel file and the MicroStation dgn file for easy
updates.

« Always make changes to spreadsheet, save and then right click on the link
In the list and choose Update Now.
Note: this is a ONE WAY process. Changes made in MicroStation cannot be updated to Excel.

?l- FDOT Linked Data Manager 1.01.10

Desoription Type Update  Lood

e s

Delete Link
Delete Link and Graphics

< Properties >

C:\e\projects Add (Create Link) F D Oﬁ
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Linked Data Manager (LDM)

Automating Plan Summary
Boxes

* When creating a link use the

Create New from Quantities option.

+ Select the QM database (*.mdb)
« Select the Summary to be created

« Save the file to the Calculations
directory of the project

Source File

Source Path

Description

Graphics Sett
@ FDOT [

() Site
() Project

& Create New from Template ﬁ Create New fram Quantities 4

Quantity Manager Summary Reports

Quantity Manager Database: | \roadway" 22043555201 mdb v | | [
Force all text imported from database to be UPPER CASE

Report Description

Summary of Bamier Walls
Summary of Curb and Traffic Separators
Summary of Ditch Pavement
Summary of Driveways

Summary of Edgedrain
Summary of Erosion Control
Summary of Fencing

Summary of French Drain
Summary of Guardrail

Summary of Mailboxes

Summary of Miscellaneous Asphalt

Summary of Permanent Crash Cushions
Summary of Railing
Summary of Sidewalk

Summary of Pavement Summary_of_Pavemert

File Name 2

Summary_of_Bamier_Walls
Summary_of_Curb_and_Tr...
Summary_of_Ditch_Pawvem...
Summary_of_Driveways_E...
Summary_of_Edgedrain
Summary_of_Erosion_Control
Summary_of_Fencing
Summary_of_French_Drain...
Summary_of_Guardrail_Ex...
Summary_of_Mailboxes
Summary_of_Misc_Asphalt

Summary_of_Pemanent_C...
Summary_of_Railing_Bxpa...
Summary of Sidewalk e

0K Cancel

FDOT\
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Linked Data Manager (LDM)

Automating Plan Summary Boxes

« Adjust the link settings and select OK to
place the links and sheet borders

Link Information

Source File
¢n'|  Create New from Template s Create New from Quantities
Source Path | Mcalculations\Summary_of _Pavems: it xsx ~ | |FE | B
Diescription | |
Q“HE”tif‘rr; F'Iace Title Block
PO
Header Rows Cell Library [roadway cel | Cell Offset X
Table Array X Cell Name |shplan | cellOffsety

Graphics Settings

(@ FDOT |Standard w |)

) Site
() Project

CD Use Drawing Scale Update Graphics on File Open  [] Lock Graphics [ Use Print Area)

Core

FDOT
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Linked Data Manager (LDM)

Automating Plan Summary Boxes

* Once placed, the plan sheet borders are not linked and can be moved or
deleted as needed. Summary boxes can also be moved. There will be a
separate link for each summary box placed.

* If a quantity changes and the boxes need to be updated, the same process can
be used. Use LDM'’s Create New from Quantities and overwrite the existing
Excel file in the Calculations folder, then cancel instead of placing new
summary boxes. Update the existing links through LDM.

Note: If there are any customizations in the Excel file (i.e. columns hidden or
widened) they will need to be reformatted in the newly created Excel file.

FDOT\
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Linked Data Manager (LDM)

Creating Plan Summary Boxes
from Templates

* When creating a link, select Create
New From Template for summary
boxes that are not included in the
automated list.

Note: The templates are available for ALL
summary boxes in the drop down for
designers who do not use D&C Manager or
Quantity Manager.

Source Rle

Source Path

I@ Create Mew from Template ‘ﬂ Create New from Quantities

omputation Summary Boxes| (ﬁ

Text Notes b
Word Documents
Misc Boxes
Data Boxes
Sheets
Computation Summary Boxes

Removal ftems

Graphics Setl | Summary of Curb and Gutter and Traffic Separators

Summary of Ditch Pavement
Summary of Driveways
Summary of Earthwaork
Summary of Edgedrain
Summary of Erosion Control
Summary of Fencing
Summary of French Drain
Summary of General tems
Summary of Geotechnical kems
Summary of Guardrail
Summary of Litter Removal and Mowing

Summary of Lump Sum lems
Ciimman nf Mailhrwas

File Name 2

Summary_of_Bamier_Walls....
Summary_of_Box_Culverts....
Summary_of_CG_and_Re...
Summary_of_Curb_and_Tr...
Summary_of_Ditch_Pavem...
Summary_of_Driveways xlsx
Summary_of_Earthwaork xdsx
Summary_of_Edgedrain xdsx
Summary_of_Erosion_Cont...
Summary_of_Fencing xdsx
Summary_of_French_Drain...
Summary_of_General_ltem. ..
Summary_of_Geotech xd=x
Summary_of_Guardrail xdsx
Summary_of_Litter_Remav...

Summary_of_Lump_5Sum_k...
Cimmanr ~f Mailhrwae wew

0K Cancel

FDOT\
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Linked Data Manager (LDM)

Creating Plan Summary Boxes
from Templates

 Save the Excel file to the Calculations
folder in the project directory.

« Once saved, the Link Information
dialog will come back up, select the
Box1 worksheet from the dropdown.

« Select the Graphic Settings.
« Select desired link settings.

+ Click OK and click in the MicroStation
file to place the link and graphics.

Source Rle

&' Create New from Template ﬂ Create New from Quantities

Source Path | \calculationsSummary_of_CG_and_Removal_ltems xlsx

mirE

fee—

Description ||

Excel Settings
C«forksheet |Box‘|

V| ) Header Rows

vidthiHeight | || | ofetxsy| |[ ] [] Use Title Cell
Graphics Settings
( @ FDOT  |Standard v )
) Site
(") Project oy

(D |Use Drawing Scale Update Graphics on File Open [ ] Lock Graphics [ ] Use Print Area)

OK Cancel

FDOT\
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Linked Data Manager (LDM)

-:': FDOT Linked Data Manager 1.01.10

Creating Plan Summary Boxes
from Templates

* Right click on the link in the LDM tool
box and select Open Source.

« Once open, add and modify data as
necessary in the Excel file and save.

* In MicroStation, right click on the link

iIn LDM again and select Update Now.

Note: Quantity Manager will generate
reports which can speed up this process.

Delete Link
Delete Link and Graphics

Properties

Ci\e\projects) Add [Create Link)

FDOT\

PRODUCTION SUPPORT OFFICE | CADD




Linked Data Manager (LDM)

Creating Plan Summary Boxes from Templates

« Summary of Structures Quantities
* Place the Plan Sheet at a scale of 12
* Do not turn on the option to use the Drawing Scale

() Projec. e

(|:| Use Drawing SCEID Update Graphics on File Open [ | Lock Graphics [ ] Use Print Area

OK Cancel

FDOT\
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Quantity Manager (QM)

Generating Reports

* In QM, set the Trns*port Grouping
setting to the appropriate category
(Roadway = 0200)

» Select the desired Pay Item in the
Pay Iltem Pane.

« Select Tools > Reports > Create
from the QM menu.

Project Edit Wiew Insert Tools Help

O = M@ E Reports »

Graphic Wiewer

Fayitern Tree  Payitem Tane

"1 Quantity Manager - C:\e\projects\AutomatedQuantities\FDOT_Automated_Cuantities...

_ root
=1 Roadway Design

=3 Quantity Features

-] Milling Existing Asph.

i#1-[[] Stahilization & Subhase

=] Base

#-[] Asphaltic Concrete

- Sidewalk

- Tur

EI J Favt Rermaoval Clearing&Grubhing
P 0110 1 1 Clearing & Grubhing
L 0110 4 Remaowal of Existing Concret
=[] Concrete & Accessories

=[] Maintenance of Traffic

ot e
a-_El |Pap atures i —

Create N |gsCD2DD v )
Cefine Styles

ey rayitem Trhs*patt ... | Chain
rootiRoadwa... 40 1 1 0zoo CLCOMN
rootiRoadwa... 40 1 1 0zoo CLCOMN
rootiRoadwa... 40 1 1 0zoo CLCOMN
rootiRoadwa... 40 1 1 0zoo CLCOMN

™ e »

FDOT\
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Quantity Manager (QM)

Generatl ng Reports Active Trns*part Groupings: 0200
- In the Create Report dialog, select the e oy AR
Report Style for the Area CSV file. Repart ile Name: | 011011 csv ey
. . Starting Page Number: | 1
* Type in a Report File Name for the output. ] Report Only Selected Quantiies
» Click Create. The file will open in Excel. I carce

 This file can be used to copy and paste the
iInformation into the Excel template file
generated through LDM.

« When pasting the information into the Excel template, make sure to use the
option for Values Only so that the formatting doesn’t change.

FDOT\
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Quantity Manager to Designer Interface

Quantities Workflow

1.

Export the Project Header information (xml file) from Designer Interface.

2. Import the project header info into Quantity Manager Project Preferences.
3.
4. Import the quantities to the project in Designer Interface.

Export the quantities report from Quantity Manager (xml file).

FDOT\
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Quantity Manager to Designer Interface

Quantities Workflow

1. Export the Project Header
Information (xml file) from Designer
Interface.

 This can be done in 2 locations...

* Project List

* Project Details (Click Update in the
Project column to display Project
Details)

« On either screen, select Export
Header.

FDOTi E Designer Interface web Trns*port Preconstruction

Logged in as: ps972kd [Logout] Webgate Reporting Home  Help

Project List

Project. Project Number aecXML Pro_ Description LettingD.. | UnitSy .  Proposal Dis
Export Header i A
Update 0000000000000 Vo CADD office testing only English T8888 (
B titnnmn B s it P e P i sl an Pt i =

FDOTi E Designer Interface web Trns*port Preconstruction

Logged in as: ps972kd [Logout] Webgate Reporting Home  Help

Project List == Project Details } 0000000000000

Federal #: N/A
Class: 7-Class 7 Type: C - Construction  Urban/Rural:

CADD FTP Site

Letting Date: District: 05 Pay Item List: 13 County: 79 - VOLUSIA  Proposal: T&G88

Work Type: X4 - Work Mix: 0218 - ADD LANES & REHABILITATE
Widening & Resurfacing PVMNT

Categories
Delete Selected ‘ Export Header l Import Add Category Copy Selected Category (none)
Delete Number Description Alternate. .. Bridge ID Update lte..  View
O 0102 Structures 111222 Update 1 View a
| 0103 Structures 111223 Update 0 View
O 0200 Roadway Update 131 View
PN SR Y «J’t PRy S S e el NP

FDOT\
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Quantity Manager to Designer Interface

Quantities Workflow

1. Export the Project Header information (xml file) from Designer Interface.

« Select the drop down option beside the Save option and choose Save As.
« Save the xml to the project discipline directory (i.e. Roadway).

Contact the Service Desk Web Policies & Notices Save
Sawve as I}}
Do you want to cpen or save 0000000000000.3eml (1.50 KB) from fdotwp1.dot.state.fl.us? Open Save b 5ave and open
I

FDOT\
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Quantity Manager to Designer Interface

"1 Quantity Manager - C:\e\projects\AutomatedQuantities)

Quantlties WOrkﬂOW Project Edit View Insert Todls Help

O Mew..

@& Open... F

2. Import the project header info into

Mew Trns*port Groupings...

Quantity Manager Project Properties. :1

Export }

 In QM, select Project > Properties. b

Properies. .. |/\\s

¢ In the PrOjeCt Propertles dialog’ SeIECt zl:’zfprfur;;:tss;utnmated'3!uantities\FDOT_Autnmatedj

Project > Import aerML Infrastructure V33 Project C:Ielprujectsw«utnmatedQuantities\FDOT_Autnmated?Q-

ClelprojectstdutomatedQuantities\FDOT_Autarmated_.
ChelprojectstdutomatedQuantities\22049555201 road

« Select the downloaded file, then select Open.

Project
Import aecxhl Infrastructure v33 Project h

Genera I Information o 7
r_.ﬁ__r-“ = Y - i — ) —— .

FDOT\

PRODUCTION SUPPORT OFFICE | CADD




Quantity Manager to Designer Interface

Quantities Workflow

2. Import the project header info into
Quantity Manager Project Properties.

« The Project Properties dialog opens with
a new tab for the Trns*port Groupings.

« Select the desired options and then click
Import.

0102 Structures

0103 Structures

0200 Roadway

0301 Signing

0400 Lighting

0400 Signalization

04550 Intelligent Transpartation System

0600 Landscape § Peripheral

0700 LHilities

0800 Architectural

R EEEEEEEEE

0900 Mlass Transit

Irnport

Cance

FDOT\
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Quantity Manager to Designer Interface

Quantities Workflow
3. Export the quantities report from Quantity Manager (xml file).
« Make sure the Trns*port Grouping Is set correctly.

* In the Payitem Table view of the Pay Item Pane, select all of the pay items
desired to be exported.

"1 Quantity Manager - C:\e\projects\AutomatedQuantities\22049555201 roadway\ECS0.mdb

Froject Edit Wiew Insert Tools Help

[0 Mew. "

= Open.. 3
close .. | chain Met v alue |R?
Mew Trns*port Groupings..
Import f
Export » Export
hWlerpe Database Define Styles L‘\? ‘
Properties... WDOT Trns*prt Format
Freferences
ClgprojectstdutomatedQuantities\220495552 01 roadwaylECSO.mdb

'C:Ialﬂ_rg}*tswtgmamdmnmuiesw‘%?igﬁﬁﬁﬂmamraumsmteﬂ.m@_...J_F.‘f R o~ ‘-‘-,

FDOT\
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Quantity Manager to Designer Interface

Quantities Workflow

3. Export the quantities report from Quantity Manager (xml file).
* On the Export dialog, select the Export

Style, aeCXML + Fundlng Active Trns*port Groupings: 0200
Export Style:  aecxhdl + Funding R
o Toggle ON the Rename Optlon and Ieave [#] Rename Trns*port Groupings As: | DesignEstimate
aS the defaUIt “DeSignEStimate”' Dol:urzue::::aen:\:r::; aDE;)D(EﬂDLDanDfrDaDS;r;LcJt:r::t‘ideS:xmI ﬂ
- Type in a name for the xml file generated. Sy e Gt
yp g Cancel

« Click Export.

« Click OK on the information dialog about Properties missing. This is normal.
The file generated will have all the necessary information.

* Click OK on the Export Complete information dialog.

FDOT\
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Quantity Manager to Designer Interface

Quantities Workflow

H Standard | CellApps | Acticns || Design Apps | Roadway | e | S | P | a| El | (2] I

3. Export the quantities report from
Quantity Manager (xml file).

In MicroStation, open the XML Quantity
Rounder tool.

Located on the FDOT Plans Development
task menu > Quantities

Quantities S
A8 &% [@u Sy
OR —on the FDOT Actions Menu under Trns*port

Click Process XML File and navigate to and select
the file exported from QM.

Click OK on the Created file dialog and then click
Finished — Exit Application.

Create Files

Set Gecgraphic Coordinate System
Set Plot Scale of File

Turn Level Filters On

Turn Level Filters Off

Q

>

7

7

Q

O Adhoc Manager

O Sheets 2
O Sheet Mavigator (Label Sheets)

O RfClip [Sheet Clipping)

€| Label Shapes with ID

O Label Shapes with Area

€| Linked Data Manager (LDM)

2
@

| AASHTOWare Project Preconstruction (TRNS"port)  » | AECITEM.xm| Download
Quality Control » Web Gate Website
FDOT TRMS*port

| Quantity Rounder t

ES XML Quantity Rounder 1.00.01

This application is used to round quantities exported from Cluantity
Manager before uploading them to TRNS*port.

The selected XML file will not be modified - a new XML file will be created
at the same file path as the original with "_rounded.xml” appended to the
filename.

| Process XML File Finizhed - Ext Application

FDOT\
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Quantity Manager to Designer Interface

Quantities Workflow

4. Import the quantities to the project
In Designer Interface.

On either the Project List or Project
Details view, click on Import.

Click on Select Files... and then
navigate to the file exported and
then rounded from the project
directory. (It will have Rounded
appended to the file name.)

Once selected click on Upload file.

FDOTi E Designer Interface web Trns*port Preconstruction

Project List == Project Details - 0000000000000 CADD FTP Site
Federal #: N/A Letting Date: District: 05 Pay Item List: 13 County: 79 - VOLUSIA  Proposal: T&G88
Class: 7-Class 7 Type: C - Construction  Urban/Rural: Work Type: X4 - Work Mix: 0218 - ADD LANES & REHABILITATE

Widening & Resurfacing PVMNT

Categories
Delete Selected Add Category Copy Selected Category (none)
Delet: Number Description Alternate. .. Bridge ID Update lte..  View
O 0102 Structures 111222 Update 1 View a
| 0103 Structures 111223 Update 0 View
O 0200 Roadway Update 131 View

PN SR Y «J’t PRy S S I T

Project List >> Project Details - 0000000000000 >> Import XML

Only upload XML files generated by Quantity Manager.

Select files.

Upload file Cancel
et et et o, g gpisinss P adP A T inde B e e B B i

FDOT\
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Quantity Manager to Designer Interface

Quantities Workflow

4. Import the gquantities to the project in Designer Interface.
* The results will show up on the screen. This is ALL or nothing.

) G re e n —_ L 0 ad Project Load Log Messages
e bata validation successtul, . Projectsuccesstullyloaded:
S ucce SSfU I 'p’:;';ﬂem sz;;W?EZEﬁOUUDDOUD n
Item: 01104 2
v
* Red - Errors e
- Project: Invalid category number. Must be numeric (E16}
(noth I ng Ioaded) Project Category ory: DesignEsti
antity:

FDOT\

PRODUCTION SUPPORT OFFICE | CADD




Summary of Pay Items

« Access Webgate Reporting
 From Designer Interface
+ From Webgate site g e e

« Select Designers, Estimators, and Reviewers > Project Edit Report
* This report should be run first

FDOTi E Designer Interface web Trns*port Preconstruction
/ e

Logged in as: ps972kd [Logout] Webgate Reporting | Home  Help

v |

to Id e ntify any e rro rS Wlth th e FD Oﬁ Florida Department of Transportation Session Time remaining: 00:19:20

pay |te ms | Oad ed on th e p I'Oj ect . g . AASHTOWare Project Webgate Reporting Kandi Daffin | Help | Logout

Project Edit Report

} Construction Sitemanager ‘

This report performs edits on the item records and will print a listing of any errors encountered. The selection criteria will be Project

( ~ Designers, Estimators, and) number. Project number is a required input parameter.
Reviewers

| Cempbook Master Payitem ., . . N
Extract Select/Enter Parameter Information: Required fields marked with asterisk(*)

*Project Number: 0000000000000 v

IS Historical Bid Item Summary
Report

I Project Edit Report

» Equal Opportunity

» General Reports

} Landscape Reports

» Maintenance Sitemanager

L i P i, g S et iia At it DA o P P

FDOT\

PRODUCTION SUPPORT OFFICE | CADD




Summary of Pay Items

« Access Webgate Reporting
 From Designer Interface
o Fr()m Webgate S| te Project List == Project Details - 0000000000000 CADD FTP Site

_,' g et o et ot bt s.._)_‘f,’.“# s L Pt s g |

« Select General Reports > Summary of Pay Items Report

FDOT Designer Interface web Trns*port Preconstruction
=

Tee Logged in as: ps972kd [Logout] Webgate Reporting | Home  Help

FD OT Florida Department of Transportation Session Time remaining: 00:19:23

i‘—ﬁ AASHTOWare Project Webgate Reporting

Summary of Pay liems

Kandi Daffin | Help | Logout

} Construction Sitemanager
» Designers, Estimators, and
Reviewers

This report produces a summary of pay items and quantities for a selected project. If proposal exist the report will be of the proposal
level, if no proposal the report will be of the proejct level. Either level, project or proposal, may be used for phase reviews; the proposal
summary must be used for final plans. Identifies the participating and non-participating quantity for each pay item. Use the button "Auto
» Equal Opportunity -Generate Proposal Sections” to assign proposal section numbers and propesal item line numbers if some items are not ordered
‘:, General Reports ) correctly in report or XML file
3 }::: n:i:;gf ::ntmmt by Click to view video for the CADD Workflow for Quantities with Designer Interface.

Ls Mote: Scroll to the bottom of the table of contents for how to create the Summary of Pay ltems Sheets.

p Item Average Unit Cost by
Item Range Report

Contract Project Directory Select/Enter Parameter Information: Required fields marked with asterisk(*)
Report

v v

Crosswalk Report

-

Master Payltem List Report

Proposal Section and Line
Numbers Report

b Summary of Pay Items
Report

» Landscape Reports

-

Select Project: 0000000000000 hd | Auto-Generate Proposal Sections

» Maintenance Sitemanager

()Report File
JCADD File

TR Jeeaeer Y S W S SV D S S P e

Report Type:

FDOT
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Summary of Pay Items

« Select the Project
« Select Report Type: CADD File
« Click Submit

« Select the Save As option

* Rename the file if the Project Header file is
named the same as the default.

Note: The Auto-Generate Proposal Sections
IS now available for Designers to run.

« |f a proposal has been generated for a
project, run this report before creating the
Summary of Pay Items if pay items have
been added or modified.

FD Oﬁ Florida Department of Transportation Session Time remaining: 00:19:23

} Construction Sitemanager

» Designers, Estimators, and
Reviewers

» Equal Opportunity
* General Reports

Item Awerage Unit Cost by
Item Number Report

p Item Average Unit Cost by
Item Range Report

p Centract Project Directory
Report
- Crosswalk Report

I» Master Payltem List Report

b Proposal Section and Line
Numbers Report

b Summary of Pay Items
Report
» Landscape Reports

» Maintenance Sitemanager

e imndl et

AASHTOWare Project Webgate Reporting

Summary of Pay liems

Kandi Daffin | Help | Logout

This report produces a summary of pay items and quantities for a selected project. If proposal exist the report will be of the proposal
level, if no proposal the report will be of the proejct level. Either level, project or proposal, may be used for phase reviews; the proposal
summary must be used for final plans. Identifies the participating and non-participating quantity for each pay item. Use the button "Auto
-Generate Proposal Sections” to assign proposal section numbers and propesal item line numbers if some items are not ordered

correctly in report or XML file

Click to view video for the CADD Workflow for Quantities with Designer Interface.
Mote: Scroll to the bottom of the table of contents for how to create the Summary of Pay ltems Sheets.

Select/Enter Parameter Information: Required fields marked with asterisk(*)

(Select Project: 0000000000000 hd ) Auto-Generate Proposal Sections
A/

) Report File

Report Type:

T W Sy P o TG P S N

Save

Do you want te cpen or save T8888.eml from fdotwp1.dot.state.flus?

Y

Save and open

FDOT\
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ummary of Pay Iltems

* |n MicroStation, select the FDOT TRNS*port tool

Quantities

= - A

q ﬂ%ﬁi‘ ;‘E:M

OR

[ standard | cellapps |

Actions | Design Apps | Roadway | ¥7 | <7 ||| [E[ @]

2
>

Create Files

Set Geographic Coerdinate System
Set Plot Scale of File

Turn Level Filters Cn

Turn Level Filters Off

Adhoc Manager

Sheets 3
Sheet Navigator (Label Sheets)

RfClip (Sheet Clipping)

Label Shapes with ID
Labkel Shapes with Area
Linked Data Manager (LDM)

& FDOT TRNS*port 3.00.20

Input File: ||

County: ~

Financial Number: v

Label Shest

Road Number: I:I

Line 1: | |
Sheet Title:
Line 2: | |

Sheet Number Preﬁx:l:l ~ | Number:

Load Summary of Pay ltems

Browse...

AASHTOWare Project Precenstruction (TRNS*port)  » |

2
2
2
7
7
7
7
2
2
2)
2]
2

Quality Control 3

AECITEM.xml Download
Web Gate Website

FDOT TRNS*port

Quantity Reunder

FDOT
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Summary of Pay ltems

« Select the Browse button and
navigate to the saved Summary of

& FDOT TRNSport 3.00.20

Input File: |C:\e'projects'\AutomatedGuantities 22045555201 roadway . TEE88 xml || Browse...

Pay Items report xml file. il et BOD000
. . [] Label Shest
« County and Financial Number are N—

pulled in from the XML file.

« Label Sheet is toggled on by default.
* Optional

Line 1: | SUMMARY OF PAY ITEMS |
Sheet Title:
Line 2: | |

Sheet Number F'reﬁx:lZI ~ | Number:

‘ Load Summary of Pay ltems C£

« Click Load Summary of Pay ltems
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Questions?

Thank you for joining today’s session!
Need HELP? Contact me...
(850) 414-4289
E-mail: Kandi.Daffin@dot.state.fl.us
OR: CADD.Support@dot.state.fl.us
http://www.fdot.gov/cadd/

FDOT CADD Support Forum On-line

https://communities.bentley.com/communities/user communities/fdot cadd support/
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